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cQué es?

e Software de cardacter privativo que permite realizar analisis
estadisticos de la evolucion molecular y la construccion de
arboles filogenéticos.

e Desarrollado en 1993 en la Universidad Estatal de
Pensilvania.



Caracteristicas

e Alineamiento y visualizacidon de secuencias
e Meétodos de estimacion de distancias
e Visualizacion y métodos de creacion de arboles

Y mucho mas...



Caracteristicas

Likelihood Distance Parsimony Bayesian Visual Explorer Caption Expert
Phylogeny v
Bootstrap v
Distance/Diversity v
Model Selection v 4
Substitution Pattern v v X v
Rate Variation v v X v
Ancestral Sequence v v v v
Clock Test v v v X v
Time Tree v v v v
Selection Test v v v v
Disease Mutation v v v X v



Instalacion

e Windows Interfaz gréfica y linea de
e MacOs comandos

e Ubuntu/ Debian

e RedHat

e Otros sistemas Linux

g > /ﬁz tiv




Windows (GUI/CLI)

Descargar el .exe de la web y seguir los pasos indicados
por el asistente.




MacOs (GUI/CLI)

Descargar el .dmg de |la web, abrirlo y arrastrar el icono de
MEGA a |la carpeta de aplicaciones en la ventana emergente.




Ubuntu/Debian(GUI/CLI) ¢33

Descargar el .deb de la web, navegar con una terminal hasta
el directorio que lo contenga y ejecutar:

GUI: sudo dpkg -i megax_10.0.5-1_amd64.deb
CLI: sudo dpkg -i megax-cc_10.0.5-1_amd64.deb



RedHat(GUI/CLI) /t,

Descargar el .rpm de la web, navegar con una terminal hasta
el directorio que lo contenga y ejecutar:

GUI: sudo rpm -ivh megax-10.0.5-1.x86_64.rpm
CLI: sudo rpm -ivh megax-cc-10.0.5-1.x86_64.rpm

En caso de tener una version anterior descargada, a lo mejor
es necesario ejecutar:

GUI: sudo rpm -ivh --replacefiles megax-10.0.5-1.x86_64.rpm
CLI: sudo rpm -ivh --replacefiles megax-cc-10.0.5-1.x86_64.rpm



Otros Linux (CLI) i
4"y

Descargar el .tar.gz de la web y extraerlo mediante el
comando:

tar -zxvf megacc-7.0.26-1.x86_64.tar.gz

Después, mover los binarios y archivos dependientes al
directorio que se prefiera.



Windows (GUI

Descargar el .exe de la web. (
M| E |G| A EEEEE
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Volunteers are needed for testing the new macOS version of MEGA X. If you are a macOS user o
‘ and would like to help, please . Note: this version is only for 64-bit macOS systems
and is only intended for testing.

Sophisticated and user-friendly software suite for analyzing DNA
and protein sequence data from species and populations.

Sequence Analyses Statistical Methods Powerful Visual Tools




Windows (GUI

Rellenar perfil.

Country
Spain
lam a....

(Check one or more)
Researcher

Instructor
Student

Professor

Other

What kind of institution is ?
Universidad de Zaragoza

Itis a...
(Check one or more)
University/College

Research Institute
Industry
Government

Other
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Convertir archivo Fasta a Mega

- File -> Convert File to MEGA

- Abrir archivo fasta con mega
y guardar la sesion
Data -> Save session




alculo de distancias

- Distance -> Compute Pairwise Distances

MX: Analysis Preferences
Distance Estimation
Opciones: -
p . ANALYSIS
Scope
ESTIMATE VARIANCE

Variance Estimation Method

SUBSTITUTION MODEL
Substitutions Type
Model/Method

RATES AND PATTERNS

Rates among Sites
Equal input model
Dayhoff model
Pattern among Lineages lor-Thornton (JTT) model

DATA SUBSET TO USE

/Missing Data Treatment




Calculo de distancias

m MX: Pairwise Distances (Chloroplast_Martin.meg)

File Display Average Caption Help

m ‘3*:‘ '—';"3 B mg mn NE‘GA rt‘r Z

1 > |

Synechocys
Odontella

Porphyra

Cyanophora

Marchantia

Pinus

Nicotiana

1.
2
3
4.
5. Euglena
6.
i
8.
9:

Zea 0.1454
10. Oryza 0.1467 0.0317

<

[1,1] (Synechocys-Synechocys) / Amino: Poisson correction




Construccion de arboles

Por distancias:

- NJ MODELS DISTANCE  DIVERSITY - z ST
: Construct/Test Maximum Likelihood Tree...

_ U PG MA Construct/Test Neighbor-Joining Tree...

Construct/Test Minimum-Evolution Tree...

Construct/Test UPGMA Tree...

Construct/Test Maximum Parsimony Tree(s)
Por maxima parsimonia:
- MP

Open Tree Session




NJ

Opciones: L

MX: Analysis Preferences

Phylogeny Reconstruction

Statistical Method Neighbor-joining
PHYLOGENY TEST

Test of Phyloge

Substitutions Type Amino acid

Model/Method

RATES AND PATTERNS

Rates among Sites

Pattern among Lineages me (Homogeneous)

DATA SUBSE SE

X | Cancel




NJ

Arbol generado:

File Search Image Subtree View Compute Caption Help

BE0D| YO &= (O)

Nicotiana
Pinus
Marchantia

Odontella

Synechocys

Cyanophora

Eu

—_—
0.050

Evolutionary relationships of taxa

The evolutionary history was inferred using the Neighbor-Joining method [1]. The optimal tree with the sum of branch length =
1.56999130 is shown. The tree is drawn to scale, with branch lengths in the same units as those of the evolutionary distances
used to infer the phylogenetic tree. The evolutionary distances were computed using the Poisson correction method [2] and
are in the units of the number of amino acid substitutions per site. This analysis involved 10 amino acid sequences. All
ambiguous positions were removed for each sequence pair (pairwise deletion option). There were a total of 11039 positions
in the final dataset. Evolutionary analyses were conducted in MEGA X [3].

1. Saitou N. and Nei M. (198
Biology and Evolution 4:40
erkand| E. and Pauling L. (1965). Evolutionai rgence in proteins. Edited in Evolving Genes and
Proteins by V. Bryson and H.J. Vogel, pp. 97-166. Academ York
2 WumarS Stachar G il Knuaz O and Tamura i (2018) MEGA Y- Malacular Eualufinnan: Ganatice Analueic acrnss

SBL = 1.56999130 Ready




MX: Analysis Preferences

Phylogeny Reconstruction '

Opciones:

ANALYSIS

Scope

Statistical Method
PHYLOGENY TEST

Test of Phylogeny

SUBST TION MODEL
Substitutions Type Amino acid

Model/Method

ES AND PATTERNS

Rates among Sites
Pattern among Lineages

DATA SUBSET TO

g Data Treatment

ancel




UPGMA

Arbol generado:

File Search Image Subtree View Compute Caption Hel

BE0D| YO &< (O)

Nicotiana

Pinus

Odontella

Synechocys

Cyanophora

Euglena

Evolutionary relationships of taxa

The evolutionary history was inferred using the Neighbor-Joining method [1]. The optimal tree with the sum of branch length =
1.56999130 is shown. The tree is drawn to scale, with branch lengths in the same units as those of the evolutionary distances
used to infer the phylogenetic tree. The evolutionary distances were computed using the Poisson correction method [2] and
are in the units of the number of amino acid substitutions per site. This analysis involved 10 amino acid sequences. All
ambiguous positions were removed for each sequence pair (pairwise deletion option). There were a total of 11039 positions
in the final dataset. Evolutionary analyses were cond d in MEGA X [3]

1. Saitou N. and Nei M. (1987). The neighbor-joining method: A new method for reconstructing phylogenetic trees. Molecuiar
Biology and Evolution 4:406-425.

erkand| E. and Pauling L. (1965). Evolutionary divergence and convergence in proteins. Edited in £ ing Genes and
p. 97-1 A v York.

Proteins by V. Bryson and H.J. Vogel, p| Academic Press, Ni
2 KumarS Stachar G il Knuaz O and Tamura i (2018) MEGA Y- Malacular Funlufinnan: Ganatice Analusic acrnse

SBL = 1.56999130 Ready




MP

Opciones:

MX: Analysis Preferences

Phylogeny Reconstruction

Option

ANALYSIS
Statistical Method
PHYLOGENY TEST

Test of Phylogeny

SUBSTITUTION MODEL
Substitutions Type

DATA SUBSET TO USE

Gaps/Missing Data Treatment

TREE INFERENCE OPTIONS

MP Search Method

No. of Initial Trees (random addition)
MP Search level

Max No. of Trees to Retain

SYSTEM RESOURCE USAGE

Setting

Maximum Parsimony

Amino acid

Tree-Bisection-Reconnection (TBR)
Min-Mini Heuristic
Max-mini Branch-&-bound

X | Cancel




MP

Arbol generado:

File

MX: Tree Explorer: (Chloroplast_Martin.meg)

Search Image Subtree View Compute A s Caption Help

Synechocys
Cyanophora
Odontella
Porphyra
Euglena
Marchantia
Pinus
Nicotiana
Zea

Oryza

Maximum Parsimony analysis of taxa

The evolutionary history was inferred using the Maximum Parsimony method. The most parsimonious tree with length = 18171 is
shown. The consistency index is 0.854603 (0.809035), the retention index is 0.693468 (0.693468), and the composite index is
0.592640 (0.561040) for all sites and parsimony-informative sites (in parentheses). The MP tree was obtained using the Subtree-
Pruning-Regrafting (SPR) algorithm (pg. 126 in ref. [1 th search level 0 in which the initial trees were obtained by the random
addition of sequences (10 replicates). This analysis involved 10 amino acid sequences. There were a total of 11039 positions in the
final dataset. Evolutionary analyses were conducted in MEGA X [2].




Exportar arboles

- File -> Export Current Tree (Newick)

Search Image Subtree View Compute Caption
B Save Current Session
Export Current Tree (New

Export Analysis Summ

Write Tree in a Table Format

Export Group Names

Import Group Names

Show Info

Print
Print in a Sheet

Printer Setup...

it Tree Explorer




ETE Toolkit

ETE

A Python framework to work with trees

Documentation reeView Support About Dow d

latest v3.1.1

Phylogenetic tree (nevvick) viewer

This is an online tool for phylogenetic w (newick format) that allows muiltig

uence alignments to be shown together with the trees (fasta format). It uses

olkit, and offers transparent integration with the NCBI taxonomy database. Currently, alignments can be displayed

in condensed or b ock-based fcm‘% Leaf names in the newick tree should match tho

When pressin g "View Tree',
Tip: Use NCBI numeric taxids as

Paste your tree in newick format:

AF443116.1:0.39975

v

IAF449632.1 :0.39975
Or upload a newick file:
Seleccionar archivo | Ningun archivo seleccionado

View tree!l  Alignment image type: | Condensed format

Share (beta): http://etetoolkit.org/treeview/?treeid=2797015fd210

Z Clear

n the fasta alignment.

ovided. You can use the link for sharing your images

nsiation of species nar

Paste your alignment in fasta format:

B e =T

TTCTAATTTAAACTATTCTCTGTTCTTTCAT =
GGGGAAGCAGATTTGGGTACCACCCAAGTATTGACTCA
CCCATCAACAACCGCTATGTATCTCGTACATT
ACTGCCAGCCACCATGAATATTGTACGGTACCATAAATA ~
CTTGACCACCTGTAGTACATAAAAACCCAAT Zl Clear
Or upload a fasta file:

Seleccionar archivo | Ningun archivo seleccionado

v |- ¥ Resolve taxonomic ids

25a42658a96f7460b&algid=cc63eff25565074e61475343a6515c14"




ETE Toolkit

Home allery Documentation reeView Support About Dow d
ETE

A Python framework to work with trees

Phylogenetic tree (nevvick) viewer

This is an online tool for phylogenetic w (newick format) that allows multiple sequence alignments to be shown together with the trees (fasta format). It uses
olkit, and offers transparent integration with the NCBI taxonomy database. Currently, alignments can be displayed

in condensed or b ock-based fcm‘% Leaf names in the newick tree should match those in the fasta alignment.
When pressing "View Tree', y data will also be provided. You can use the link for sharing your images
Tip: Use NCBI numeric taxids as leaf names (or in the format Tax|D.sequenceName) to get on-the-fly translation of species name

Paste your tree in newick format: Paste your alignment in fasta format:

B e =T

TTCTAATTTAAACTATTCTCTGTTCTTTCAT =
GGGGAAGCAGATTTGGGTACCACCCAAGTATTGACTCA
AF443116.1:0.39975 CCCATCAACAACCGCTATGTATCTCGTACATT
' ¥ ACTGCCAGCCACCATGAATATTGTACGGTACCATAAATA ~
AF449632.1:0.39975 4 Clear CTTGACCACCTGTAGTACATAAAAACCCAAT 4l Clear
Or upload a newick file: Or upload a fasta file:

Seleccionar archivo | Ningun archivo § i Seleccionar archivo | Ningun archivo seleccionado

Insertar arbol en formato newick

View tree!l  Alignment image type: | Condensed format v |- ¥ Resolve taxonomic ids

Share (beta): http://etetoolkit.org/treeview/?treeid=2797015fd210e7025a42658a96f7460b&algid=cc63eff25565074e61475343a6515c14"




ETE Toolkit

ETE

A Python framework to work with trees

Documentation Dow d

latest v3.1.1

Support About

Phylogenetic tree (nevvick) viewer

This is an online tool for phylogenetic nick forma

in condensed or b ock-based fcm‘% Leaf names in the

When pressin g "View Tree',

Tip: Use NCBI numeric taxids as

Paste your tree in newick format:

AF443116.1:0.39975

v

IAF449632.1 :0.39975
Or upload a newick file:
Seleccionar archivo | Ningun archivo seleccionado

treel  Alignment image type:| Condensed format

Share (beta): http://etetoolkit.org/treeview/?treeid=2797015fd210

at) that allows muilti
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Paste your alignment in fasta format:

B e =T

TTCTAATTTAAACTATTCTCTGTTCTTTCAT
GGGGAAGCAGATTTGGGTACCACCCAAGTATTGACTCA
CCCATCAACAACCGCTATGTATCTCGTACATT
ACTGCCAGCCACCATGAATATTGTACGGTACCATA
CTTGACCACCTGTAGTACATAAAAACCCAAT

Or upload a fasta file:

Seleccionar archivo | Ningun archivo seleccionado

Insertar alineamiento en
formato fasta

a6515c14"

v |- ¥ Resolve taxonomic ids

e7025a42658a96f7460b&algid=cc63eff25565074e6147534



ETE Toolkit

ETE

A Python framework to work with trees

Documentation reeView Support About Dow d

latest v3.1.1

Phylogenetic tree (nevvick) viewer

This is an online tool for phylogenetic w (newick format) that allows muiltig

uence alignments to be shown together with the trees (fasta format). It uses

olkit, and offers transparent integration with the NCBI taxonomy database. Currently, alignments can be displayed

in condensed or b ock-based fcm‘% Leaf names in the newick tree should match tho

When pressin g "View Tree',
Tip: Use NCBI numeric taxids as

Paste your tree in newick format:

AF443116.1:0.39975

v

IAF449632.1 :0.39975
Or upload a newick file:
Seleccionar archivo | Ningun archivo seleccionado

View tree!l  Alignment image type: | Condensed format

Share (beta): http://etetoolkit.org/treeview/?treeid=2797015fd210

Z Clear

n the fasta alignment.

ovided. You can use the link for sharing your images.

nsiation of species nar

Paste your alignment in fasta format:

B e =T

TTCTAATTTAAACTATTCTCTGTTCTTTCAT =
GGGGAAGCAGATTTGGGTACCACCCAAGTATTGACTCA
CCCATCAACAACCGCTATGTATCTCGTACATT
ACTGCCAGCCACCATGAATATTGTACGGTACCATAAATA ~
CTTGACCACCTGTAGTACATAAAAACCCAAT Zl Clear
Or upload a fasta file:

Seleccionar archivo | Ningun archivo seleccionado

Elegir tipo de imageny

v |- ¥ Resolve taxonomic ids <— resolver ids taxondmicos

25a42658a96f7460b&algid=cc63eff25565074e61475343a6515c14"




ETE Toolkit

Do not display alignment

Condensed format

gibbon




ETE Toolkit

Do not display alignment

Condensed format

gibbon




ETE Toolkit

aligned blocks
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